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1. Revision History 

 
Date Version Description 

September 20, 2012 .1 Initial Draft.  

December 24, 2012 1.0 First Release 

 
 

2. Introduction 

1.1 Objective 

 
The objective of this document is to provide details on using and interpreting the information 
available on the Automated Dispatch System (ADS) user interface, referred to as the ADS Client.  
This document will touch on portions of the real time market timeline and processes, but will be 
limited to how data is displayed in ADS. 
 
Additional Information regarding dispatching rules and procedures can be found in the Business 
Practice Manuals for Market Operations and Market Instruments, which can be downloaded at: 
http://www.caiso.com/235f/235f939f8dc0.html 

1.2 Document Updates 

 
This document will be updated whenever there is a change that impacts the usability or 
information provided in ADS.  ADS Client updates that only involve bug fixes and do not have an 
impact to intended functionality or usability will not be described in this document. 

3. System Overview 
 

http://www.caiso.com/235f/235f939f8dc0.html


ADS displays commitment (start – up / shut down / transition) instructions, energy instructions, 
and ancillary services awards from the real-time market application.  The energy instructions 
include 5 minute dispatch operating targets (DOT) from the RTED, 10 minute contingency 
dispatch (RTCD/RTDD), Exceptional Dispatch, and Hourly Intertie Instructions from the Hourly 
Scheduling Process (HASP). 

4. Panel Overview 

4.1 Batch Status / Interval Display / Alarm Management Panel 

 
 

¶ When a new batch is received, the column for the received batch will flash red until 
acknowledged by clicking on the column. 

 

¶ Selecting the column will acknowledge the alarm which will stop the column from flashing 
red.  Selecting the “Clear All Alarms” button will acknowledge the alarms. 

 

¶ When a column is selected, all resources with records for the received batch will be 
highlighted.  A second click on the column will remove the highlight. 

 

¶ When the filter box is selected, only resources with records for the filtered batch will be 
displayed. 

 

¶ When the Continuous Alarm on Receipt of New Instructions is selected, the alarm will run 
continuously until acknowledged.  A user must select on the Batch Column to acknowledge 
the batch which will mute the alarm. 

 

¶ Current Interval vs Dispatch Interval – The current interval displays the time period that is 
currently active in real time.  The dispatch interval displays the time period that is currently 
being displayed and will become real time once it reaches the current clock time.  Since 
Exceptional Dispatch records may have several active time periods, the columns are used to 
display whether there are active records for the time period and the type of active records. 
 

¶ The Received/Status display the time that the last batch was received.  In addition, the status 
will display a countdown timer for Hourly Instructions, which will indicate how much time is 
left in the current response period.   

 

4.2  Message Panel 

 
 
The panel shows a chronological history of the batches that were received by the ADS Client.  
This is a good indicator to determine if ADS is connected and receiving data. Each batch has a 



verbal description of the type of data contained in the batch as well as a unique batch id.  The 
batch id is primarily used by other automated systems that may use the batch id when 
programmatically pulling data into their 3

rd
 party systems. 

 

4.3  Resource Panel 

 

 

 
 
This is the main display which provides resource id specific data including MW totals, relevant 
times, and other resource specific information.  More information will be provided on this display 
in the Real Time and Hourly Pre-Dispatch tab section. 
 

¶ The default view will contain a Resource ID column.  The Resource Ids from the screen print 
above have been removed. 
 

¶ An instruction is considered valid and will have a green valid box if ADS can confirm that the 
instruction was received by a user with write access.  Otherwise, the instruction is considered 
invalid and the valid box will be red. 

 

4.3.1 Editing Resource Tabs 

¶ There are two resource tabs that are included with the default installation, Real Time and 
Hourly PreDispatch.  Resource tabs can be created by Navigating to the View menu and 
selecting New.  Once the resource tab is created, the user must select Save View Settings 
under the View menu for the view settings to remain after the ADS is closed.   
 

¶ Columns can be added or removed by right clicking on any column header and selecting 
Field Chooser. 

 



  
 
¶ Custom filters can also be created for each Resource Tab.  A filter can be created as follows:  

1) Select the Filter or Customize button to display the Filter Builder 

      

 
 
2) Conditions can be added or removed by selecting the box next below: 

 

 
 
3) Choose a column to filter by clicking on the column record to bring up the drop down.   



 

      
 

4)  Several functions can be performed by opening the Operations menu. 

 

 
 

5) The filter can be deleted or deactivated by selecting the checkbox and X buttons on 
the bottom on the Resource panel. 



 
 

¶ Columns can be calculated by right clicking on the grey bar below the resource panel.  The 
available calculations include Summation, Minimum, Maximum, Count, and Average.  
Calculations can be removed by selecting None. 

 
 

 
 

4.4  Trajectory Plot 

 

 
 
The Trajectory Plot shows tracks a history of the dispatch operating targets, DOTs, and dispatch 
operating points, DOPs, for the resource selected in the Resource panel.  The DOT is the 
instruction go-to MW that the resource should be following.  The DOP is primarily used in 
Settlements which considers where the resource to ramping to and from to calculate Expected 



Energy on a 5 minute basis. The DOP is based on the Operating Ramp Rate submitted by the SC 
in SIBR.  For more information on the relationship between DOPs and DOTs, please refer to 
CAISO New Market DOP Ramping Logic document found at the following url:   
http://www.caiso.com/Documents/NewMarketADSDOPRampingLogic.pdf 
 

4.5  Instructions Detail 

 
 

The Instructions Detail also shows a chorological history of the DOTs for the resource selected in 
the Resource panel and as well as additional detail which may not be in the Resource panel.  The 
Instructions Detail panel can be customized with the Field Chooser and Filter, similar to the 
Resource panel. 

 
 

5. Real Time Tab 
 
The Real Time tab is filtered to exclude Hourly Pre-Dispatch resources.  The Real Time tab is 
primarily used to view generator energy dispatches, commitments, and AS Awards.  The energy 
dispatches include 5 minute RT dispatches, 10 minute contingency dispatches, as well as 
Exception Dispatches which can vary in duration. 

 

5.1  RT DOT Dispatch Timing: 

 

 
Under normal operating conditions, generation instructions are received every 5 minutes and are 
binding.  The time of the screenshot below (Figure 1) is 17:54:44, this is the ADS System Time in 
the lower right hand corner.  At this time, the Interval panel will display the current 5 minute 
interval, which corresponds to the previous DOT and what the resource should currently be 
following.  The Interval panel will also display the dispatch interval, which represents the 
upcoming 5 minutes and what the resource will begin to follow. 
Resources begin ramping at the beginning of the interval and are expected to reach the Dispatch 
Operating Point, DOT in the middle of the interval.   
 

http://www.caiso.com/Documents/NewMarketADSDOPRampingLogic.pdf


¶ In the example below, the resource received the instruction at 17:50:53.  The operator 
then has 90 seconds to review their instructions before the resource would begin ramping 
at 17:52.30 and reach the DOT of 29.16 MW at 17:57:30.  

 

 
 
 

5.2  Exceptional Dispatches: 

ED instructions are created manually by the CAISO operator for a specific resource.  There are 
no specific intervals for ED instructions.  Resources are expected to follow the MW value from the 
ED Min, ED Max, or ED Fixed columns in the Resource panel.  The Start and End Times are 
included in the default view of the Instruction Panel and can also be added to the Resource panel 
by using the Field Chooser.   
 

¶ A list of valid ED Codes is found at the URL below:   

http://www.caiso.com/Documents/2330C.pdf 
 

¶ There may be multiple ED Min instructions for the same period, with different MW values.  
This is often a commitment ED to pmin for multiple hours, and a ramping ED.  In general, 
the highest MW value should be followed for ED Min instructions. 

 

¶ Although an ED will drive the RT DOT, it will always obey the resources ramping 
constraints so the operator could choose to just pay attention to the RT DOT and use the 
ED instructions as an outlook of what to expect in the upcoming intervals. 

 

http://www.caiso.com/Documents/2330C.pdf


¶ The example below shows a resource that has a current DOT of 378.62 MW with a target 
time of 13:47:30, but also received an ED Min instruction of 240 MW for 13:00 – 14:00.  
The instructions are not conflicting since the ED is communicating to generate 240 MW at 
a minimum, and the DOT is greater than 240 MW.  The resource should be following the 
5 minute instruction which considers the ED that was sent previously.  As you can see in 
the detail panel, there are active ED instructions thru HE 18, so the resource will continue 
to get DOTs above 240 unless a new lower ED is created.   

 

 
 
 
 

5.3  Commitment Instructions: 

Start-Up Instructions are sent prior to the initial DOT instruction and communicate when a 
resource needs to be coming online.  The resource should follow the Start Time, and End Time 
in the Instruction panel.  The Start and End time is based on your start-up time in the CAISO 
Masterfile.  The example in Figure 3 is communicating to start up at 14:22 and reach PMIN of 45 
MW at 14:30.  The resource will receive a DOT greater than or equal to PMIN at target time 
14:32:30.  For a shut down instruction, the resource is expected to begin ramping down at the 
time communicated in the Start Time column and reach PMIN to shut down at the time 
communicated in the End Time column. 
 



 
 

5.4  Transition Instructions: 

Transition Instructions are a type of commitment instruction for MSG resources that communicate 
when a resource must transition between configuration ids.   The Unit Commitment column is 
populated with “Transition” when a Transition Instruction is received for a resource.  Commitment 
To and From Config ID columns are provided to communicate which configurations are 
transitioning, and the Commitment Start Time is used to communicate the target time for 
completing the transition.   

 

5.5  AS Awards: 

Under normal operating conditions, Ancillary Service Awards are sent every 15 minutes.  There 
are Current AS Total columns communicate the AS that was awarded during for current interval 
and the Dispatch Interval columns communicate the AS that was awarded for the next 15 minute 
interval.   Note, that the AS Awards are not energy instructions.  If there were energy being 
dispatched from an AS Award, it would be included in the RT DOT and listed in the energy 
breakdown, which is visible by hovering the mouse over the red triangle next to the MW total. 
 



 

6. Hourly Pre-Dispatch Tab 
 
Hourly Instructions are sent for intertie resources approximately 6 minutes after the top of the 
hour and must be responded to during the participant response window.  The participant 
response window begins from time the instruction is received and lasts 5 minutes.  After the 5 
minute participant response window has expired, the CAISO operator will have until 45 minutes 
after the hour to respond to a dispatch.  The example in Figure 4 in showing a resource that 
received a Hourly DOT of 2 MW.  Only Supplemental Energy can be declined, so the participant 
could have declined a portion of the -9 MW of supplemental energy.  Failure to respond to a 
dispatch will result in an auto decline of all supplemental energy and the Accepted DOT will 
reflect the Hourly Scheduled MW. 

 

¶ Hourly Predispatch Resources also receive non-binding 5 minute instructions.  These 
instructions are advisory only.  The Accepted DOT from the Hourly Predispatch run is 
binding and should be followed. 
 

¶ Hourly AS Awards for Tie Generators may also displayed on the Hourly Predispatch tab, 
provided they have a Hourly Predispatch flag = Y. 

 



 
 

6.1  Responding the Multiple Dispatches  

 
The selection of multiple dispatches is similar to other Windows bases applications. The user 
holds the Ctrl or Shift key on the keyboard and then selects the instructions that they want to 
respond to with the same response.  After the desired instructions are selected, the user then 
makes a selection on the Accept or Decline window in the upper left hand corner of the screen.  
Please note that a response for a partial quantity is not compatible with this feature and must be 
responded to individually. 
 

6.2  Instruction Priority 

 
The priority column aids in distinguishing instructions with a supplemental component and which 
instructions still need a response.  By clicking on header of the priority column the instructions will 
be sorted by priority number.  The priorities are listed below. 
 

Priorities: 
0.  Instructions requiring a response with Supplemental Energy values.  These 
instructions will be flashing in Green (until responded, then solid Green.)  
1.  Instructions requiring a response without Supplemental Energy values.  These 
instructions will be flashing in Green (until responded, then solid Green.) 
2.  Instructions not requiring a response but with Delta DOT <> 0 and all ED Fixed DOT 



instructions.  These instructions will be solid Green. 
3.  All other instructions.  These instructions will be solid Aqua. 
99. Resources with no current instructions (inactive).  These instructions will be solid 
Gray. 
 

6.3  Accepting in ADS and Tagging 

The accepted MW value in ADS is sent to the CAISO Interchange Transaction Software (CAS) 
system and matched with each Request for Interchange (e-Tag).  Mismatches between the 
accepted MW value in ADS and the MW value submitted on the e-Tag will result in uninstructed 
deviation.   
  

7 Messages 
 
In the event that a CAISO operator would like to communicate a message to all ADS users, the 
CAISO operator has the option send message through ADS.  The message will display as a pop-
up on the main pane for all users.  The message will remain in queue for 24 hours and the latest 
message will display after logging in if it has been less than 24 hours and the user has not 
already received the message. 

8 Alarms and Notifications 

8.1  Alarms Tab 
 
ADS has the ability to create custom alarms by dispatch type.  In the event that multiple dispatch 
types are received at the same time, the alarms can be prioritized to determine which alarm will 
trigger first.  The alarms are managed in the Alarms tab, found under the File / Options menu. 
Please see new Alarm tab below: 
 

¶ The user has the option to set priorities by batch type.  This will determine which alarm 
will be played first when there are multiple batches received at the same time. 

 

¶ The default Alarm is a verbal description of the batch.  Changing alarm sounds to a 
custom sound can be set on the Alarms tab or by navigating to the machine’s system 
Control Panel. 
 

¶ The Alarm Options are specific to batch type.  This means that different alarm options 
can be chosen per instruction type.  Note that the Continuous Alarm on receipt of 
New Instructions is selected for all batch types by default.  If this is desired, then the 
box must be unchecked for each batch type.  Refer to the previous section on responding 
to alarms on the Alarm panel. 
 

¶ In addition to the existing Audible Sounds ADS will also display a pop up when the 
Display Message Popup Window  box is selected for the batch type 

 

 



 
 

6.1  General Tab 
 
Additional notifications are managed in the General tab, found under the File / Options menu.  
 

¶ Selecting Bring New Instructions to Front will allow ADS to pop up in front of other 
applications whenever an instruction is received.  For example, if an instruction is 
received while working on a spreadsheet and ADS is minimized, ADS will no longer be 
minimized and will be viewed in front of the spreadsheet.   

 

¶ Selecting the Show Response Window when Accept DOT is clicked will open a 
response window after selecting the Accept button on the Hourly Pre-Dispatch tab. 

 

7 Query Tool  

7.1  Historical Data 
 



The Query Tool can be opened by selecting the button in the upper left hand corner or selecting 
Query Tool from the File menu. 

 

 
 

7.1.1 Start and End Dates 

 

 
 

¶ Drop-down calendars allow for selecting the start and end dates, or the 
dates can be entered directly. 

 

¶ The Query Tool will allow a date range of up to 90 days to be returned with 
a single query. 

 

7.1.2 Batch Type Selections 

 

¶ The Batch Types drop-down menu allows you to select batch types for 
querying.  
 

 
 

1. Select the Batch Types drop-down arrow.  
 

2. Select the Batch Type that you would like the query to return. 
 
3.  DOT, Commitment, and AS Awards are selected by default. 

 

7.1.3 Resource Drop-Down Menu 

 
The Resources drop-down menu requires you to select a single resource for querying.  
 

1. Select the icon to open the resource id menu    
 
          2. Highlight a single resource from the drop down menu. 
 
 



7.1.4 Submit and Cancel Query 

 

¶ Submit a query by selecting the   icon 

¶ Cancel a query by selecting the  icon. 

7.2 Query Results 
 

7.2.1 Customizing the Display 

 
¶ Columns can be sorted by left clicking on the column heading or right clicking 

on the column heading and selecting one of the sorting and grouping options.   
 

¶ Additional columns are also available by right clicking on a column header and 
selecting Field Chooser.  Columns can be added or removed by clicking and 
dragging the column header. 

 

¶ Select Save View Settings under the View menu to retain settings after the 
Query Tool is closed.  Selecting Reset View Settings will return back to default 
settings. 

 

 

7.2.2 Saving Results 

 
¶ Results can be saved in CSV and XML formats.  Once saved, Date and 

Times will be in GMT format. 

7.2.3 XML Download Options 

 
¶ The Query Tool supports two download versions in order to match the xml 

schemas supported for the API.   
 

¶ New data fields provided with each release will only be available when 
selecting ADS API Version 2.  The default is ADS API Version 2. 

 

¶ The Query Tool Options tab is available by selecting Options under the File 
menu.  

 



 
 

8 Submit Bug Report 
 
The Submit Bug Report, found under the Help menu, can be used to submit issues or questions 
to the CAISO Helpdesk.   Submissions will follow the same process as when a user calls and logs 
a ticket with the Help Desk.  For data related issues, please include all relevant metadata such as 
date, time, resource id, etc.  All submissions should also include the following contact information: 
 

1. Name: 
2. Company: 
3. Email address: 
4. Contact Phone: 

 

9 Installation Tips 
 
Installation steps are covered in detail in the ADS Installation Procedures; however, the following 
are some common issues and questions 
 

¶ When logging in, the user can choose to log into Production or Market Sim.  If “Don’t ask 
me again” selection is selected, then the next log in will default to the previous selection.  
The server selection can be reset by selecting Forget Server Selection under the Help 
menu after you log into ADS. 

 



 
 

¶ View Server Information under the Help menu will confirm the environment you are 
connected to. 

o Production is adssta.caiso.com 
o Market Sim is adsmktsim.caiso.com 

 

¶ The username and password are the same as the username of the certificate and the 
password is the pin that was provided with the certificate 

 

¶ The certificate must be saved in the ADS keystore folder.  The default location is:  
C:\Program Files\California ISO\ADS\keystore 

 

¶ The Instructions for Installing the ADS Software is found at the following url: 
http://www.caiso.com/Documents/Instructions_InstallingADSSoftware.pdf 

 

10 Security 
 
Access to data is based off of the certificate used when logging in.  Access can be granted at the 
SC id, Resource Type, or Resource ID level.   

 
¶ Requests must be submitted by the delegated point of contact for the SC id being 

requested.   
 

¶ A User Application Access Request Form (AARF) is required for all requests.  The AARF 
is located at the following url: 

¶ http://www.caiso.com/Documents/UserApplicationAccessRequestForm.xls 
 

¶ Requests limiting access to less than an entire SC id portfolio such as a resource type or 
individual resource, also require an Access Control List (ACL) form.  The ACL is located 
at the following url: 

¶ http://www.caiso.com/Documents/ACLInformationForm_UpdatedApr13_2011_.xls 
 

11   Data Dictionary 
 

This section contains a data dictionary of the columns that are available in both the 

Resource and Instructions Panel. 

 

http://www.caiso.com/Documents/Instructions_InstallingADSSoftware.pdf
http://www.caiso.com/Documents/UserApplicationAccessRequestForm.xls
http://www.caiso.com/Documents/ACLInformationForm_UpdatedApr13_2011_.xls


Resource Panel Default Columns       

Column Name Description Example RT Tab Hourly Tab 

Valid The instruction is valid if it was received 
by an ADS Client with Primary access to 
the resource. 

Green - Valid 
Red - Not Valid 

Y Y 

AGC The AGC flag will communicate when a 
resource was on AGC (Automatic 
Generation Control) at the start of the 
real-time market run. 

Y/N Y N 

Res Type A description of the Resource ID 
receiving the dispatch. 

Gen, TG (Tie Gen), 
ITIE, ETIE 

Y Y 

Resource ID Resource ID from ISO Master File. Gen_7_Unit1 Y Y 

Config ID Displays the MSG configuration 
associated with the dispatch. 

Gen_7_Unit1_1 Y Y 

DOT Type Whether the record is applicaple for an 
upcoming interval. 

DOT 
Inactive 

Y N 

SC ID The Scheduling Coordinator ID 
associated with the Resource ID. 

SC01 Y Y 

RT Prev DOT Dispatch Operating Target MW for the 
previous 5 minute instructions for the 
dispatch interval 

MW value Y N 

RT DOT Dispatch Operating Target MW for 5 
minute instructions, for the dispatch 
interval. 

MW value Y N 

RT DOT Delta MW Increase or Decrease from the 
previous RT instruction. 

MW value Y N 

DOT Start Time The time the resource should reach the 
RT DOT MW, ie the target time. 

15:02:30 
15:07:30 

Y N 

ED Fixed A set MW value that should be provided. MW value Y Y 

ED Min The resource should not provide below 
this MW value. 

MW value Y Y 

ED Max The resource should not provide above 
this MW value. 

MW value Y Y 

Unit Commitment Communicating the type of commitment 
instruction. 

Startup 
Shutdown 
Transition 

Y N 

Commitment Start Time When the resource should begin the 
ramping up/down or transition. 

Time Value Y N 

Current AS Total Total AS for the current 15 minute 
interval. 

MW value Y Y 

Dispatch AS Total Total AS for the next 15 minute interval. MW value Y Y 

Dispatch Spin Spin award for next 15 minute interval. MW value Y N 

Dispatch Non Spin Non Spin award for next 15 minute 
interval. 

MW value Y N 

Dispatch Regl Up Regulation Up award for next 15 minute 
interval. 

MW value Y N 

Dispatch Regl Down Regulation Down award for next 15 
minute interval. 

MW value Y N 



Priority A number value to aid in sorting, see 
Instruction Priority section for more 
details. 

0, 1, 2, 3, 99 Y Y 

Commitment To Config Displays the configuration that a 
resource should be transitional to when a 
transition instruction is sent.   

Gen_7_Unit1_2 Y Y 

Hourly Prev DOT Dispatch Operating Target for the current 
Hourly Interval 

MW value N Y 

Hourly Delta DOT MW Increase or Decrease from the 
previous Hourly instruction. 

MW value N Y 

Hourly DOT Dispatch Operating Target for the next 
Hourly Interval 

MW value N Y 

Hourly DOT Start Time The start time of the next Hourly interval, 
which corresponds to the Hourly 
Instruction 

Time Value N Y 

Accept Status Participant Accept Status for intertie 
instructions. 

ACCEPT, NON-
RESPONSE, 
DECLINED, 
PARTIAL 

N Y 

Accept DOT Participant Accepted DOT for intertie 
instructions. 

MW value N Y 

Reason Participant Reason for declined or 
partially accepted intertie instructions. 

Bid Error N Y 

Opr Accept Status Operator Accept Status for intertie 
instructions. 

ACCEPT, NON-
RESPONSE, 
DECLINED, 
PARTIAL 

N Y 

Oper Accept DOT Operator Accept DOT for intertie 
instructions.  This is the final accepted 
value. 

MW value N Y 

Opr Reason Operator Reason for declined or partially 
accepted intertie instructions. 

Transmission N Y 

Responder Participant Responding to the instruction, 
based on the certificate used at log in. 

SC01_xBPosey N Y 

Operator N/A - System Response Automated N Y 

          

Resource Panel Available Columns (Accessed with Field Chooser)     

Column Name Description Example     

ACA Flag N/A       

Commitment End Time When the resource should reach PMIN 
for start up, zero for shut down, the new 
configuration for transition 

Time Value     

Commitment From 
Config 

Displays the configuration that a 
resource should be transitional from 
when a transition instruction is sent. 

Gen_7_Unit1_1     



Contingency Type The Contingency Type will communicate 
when operating reserves are prioritized 
over energy-only bids, which will be 
labeled as RTDD, Real-Time 
Disturbance Dispatch.  The existing non 
RTDD contingency dispatches are 
labeled RTCD, Real-Time Contingency 
Dispatch. 

RTDD 
RTCD 

    

Current MSS LF Down Metered Subsystem Load Following 
Down for the current interval 

MW value     

Current MSS LF Up Metered Subsystem Load Following 
Down for the current interval 

MW value     

Current Non Spin Non Spin Award for the current interval MW value     

Current Reg Down Reg Down Award for the current interval MW value     

Current Reg Up Reg Up Award for the current interval MW value     

Current Spin Spin Award for the current interval MW value     

Dispatch MSS LF Down Metered Subsystem Load Following 
Down for the next interval 

MW value     

Dispatch MSS LF Up Metered Subsystem Load Following 
Down for the nextinterval 

MW value     

DOT End Time N/A       

ECA Flag N/A       

ED Fixed End Time The end time of a Fixed ED instruction. Time Value     

ED Fixed Energy Code The code describing the reason for the 
Fixed ED instruction 

ASTEST, BS, 
SYSEMR, etc. 

    

ED Fixed Start Time The start time of a Fixed ED instruction. Time Value     

ED Fixed UID A unique code associated with the 
insruction, which no business meaning. 

DISP-A-44475A-
54567-F357AS…. 

    

ED Max End Time The end time of a Max ED instruction. Time Value     

ED Max Energy Code The code describing the reason for the 
Max ED instruction 

ASTEST, BS, 
SYSEMR, etc. 

    

ED Max Start Time The start time of a Max ED instruction. Time Value     

ED Max UID The ED describing the reason for the 
Max ED instruction 

DISP-A-44475A-
54567-F357AS…. 

    

ED Min End Time The end time of a Min ED instruction. Time Value     

ED Min Energy Code The code describing the reason for the 
MIN ED instruction 

ASTEST, BS, 
SYSEMR, etc. 

    

ED Min Start Time The start time of a Min ED instruction. Time Value     

ED Min UID A unique code associated with the 
insruction, which no business meaning. 

DISP-A-44475A-
54567-F357AS…. 

    

Has Hourly AS Communicates whether a dispatch 
includes Hourly AS.  This includes a 
value of zero if the resource had a bid. 

true / false     

Has RT AS Communicates whether a dispatch 
includes Real Time AS.  This includes a 
value of zero if the resource had a bid. 

true / false     

Hourly DOT End Time N/A       

Hourly Meter LF Energy N/A       

Hourly Non-Spin N/A       



Energy 

Hourly Pre-Dispatch N/A       

Hourly Ramp Energy N/A       

Hourly Scheduled 
Energy 

N/A       

Hourly Scheduled MW The portion of the Hourly DOT which is 
from the DA Award.  Also included in the 
Hourly DOT dialog box. 

      

Hourly Spin Energy N/A       

Hourly Suppl Energy The portion of the Hourly DOT which is 
from the HASP Award.  Also included in 
the Hourly DOT dialog box. 

      

Intertie ID Same as the Resource ID, except the SC 
ID portion has been removed to assist 
with sorting.  For Interties only. 

SYLMAR_I_F_DA01     

Min Accept N/A       

MSS LF Down Flag Instruction includes a MSS Load 
Following Down 

Checkbox     

MSS LF Up Flag Instruction includes a MSS Load 
Following Down 

Checkbox     

Path Exclusion Communicate when a group of interties 
were excluded from a Contingency 
Dispatch market run.  The field will 
display NTE when Northern ties (those 
delivered over scheduling points North of 
path 26) were excluded.  The field will 
display STE, when Southern ties (those 
delivered over scheduling points South of 
path 26) were excluded.  The field will 
display NSTE, when both Northern and 
Southern ties were excluded. 

STE 
NSTE 

    

RMR The RMR flag will communicate when a 
resource is being incremented above the 
day- ahead schedule in real time, due to 
a RMR contract.   

Y/N     

RT Interval Numerical value indicating the 5 minute 
interval for the hour 

1,2,3,….12     

RT Meter LF Energy The portion of the RT DOT which is 
comprised of Load Following Energy. 

MW value     

RT Non-Spin Energy The portion of the RT DOT which is 
comprised of Non-Spin Energy. 

MW value     

RT Ramp Energy N/A.  A calculated value intended to be 
the portion of the RT DOT which is 
comprised of Ramp Energy. 

MW value     

RT Scheduled Energy N/A       

RT Scheduled MW The portion of the RT DOT which is 
comprised of Day Ahead Schedules 

MW value     

RT Spin Energy The portion of the RT DOT which is 
comprised of Spin Energy. 

MW value     



RT Suppl Energy The portion of the RT DOT which is 
comprised of Supplemental Energy from 
Real Time Market. 

MW value     

          

Instructions Detail Panel Default Columns       

Column Name Description Example     

Valid The instruction is valid if it was received 
by an ADS Client with Primary access to 
the resource. 

Green - Valid 
Red - Not Valid 

    

Instruction Type Indicates the type of Energy Instruction, 
AS Award, or Commitment that was 
received. 

DOT, NR, ED Min, 
Start up 

    

Instr MW The MW value of the Energy Instruction, 
AS Award, or Commitment. 

MW value     

Award MW AS Award MW MW value     

Self Sched MW The portion of the AS Award which is 
Self Scheduled in Real Time 

MW value     

Start Time The Start Time of the Instruction Time Value     

End Time The End Time of the Instruction Time Value     

ED Energy Code The code describing the reason for the 
ED instruction 

ASTEST, BS, 
SYSEMR, etc. 

    

Prev Goto Dispatch Operating Target MW for the 
previous instruction 

MW value     

Min Accept N/A       

Accept DOT The final value that was accepted and is 
expected to be provided. 

MW value     

Accept Status Participant Accept Status for intertie 
instructions. 

ACCEPT, NON-
RESPONSE, 
DECLINED, 
PARTIAL 

    

Responder The name of the certificate that is used to 
respond to an instruction. 

SC12_bsmith     

Batch Id A unique code associated with the batch 
of instructions, which no business 
meaning. 

DISP-M-44475A-
54567-F357JK…. 

    

Instuction Id A unique code associated with the 
insruction, which no business meaning. 

DISP-P-44475A-
54567-F123LP…. 

    

From Config ID Displays the configuration that a 
resource should be transitional to when a 
transition instruction is sent.   

Gen_7_Unit1_2     

To Config ID Displays the configuration that a 
resource should be transitional from 
when a transition instruction is sent.   

Gen_7_Unit1_2     

          

Instructions Detail Panel Available Columns (Accessed with Field Chooser)     

Column Name Description Example     

AGC The AGC flag will communicate when a 
resource was on AGC (Automatic 
Generation Control) at the start of the 
real-time market run. 

Y/N     



Cleared MW The sum of the AS Award and AS Self 
Schedule 

MW value     

DOT Dispatch Operating Target MW for the 
dispatch interval. 

MW value     

Penalty Bid Segment N/A       

RMR A flag indicating if the instruction is a 
RMR Instruction 

Y/N     

RMR Test Requestor N/A       

 

 
 


